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ABOUT THE This user's guide is for teachers, parents, and students. 

USER'S GUIDE Students may want to use it alone, with a friend, or with a 
small group of classmates. 

This guide is divided into the following sections: 

Introduction-introduces you to the guide, the program, and 
the main screen. 

Getting to Articles-shows you how to use the paths to 
open articles. 

Looking at Articles-shows you how to move around in 
articles and how to print them. 

Using the Tools-shows you how to use the on-screen tools. 

Using the Menu Bar-shows you how to use the online help 
and other menus. 

This is Inspector GoldenTM. In this guide he will give you 
instructions about how to use First ConnectionsB: The Golden 
Book EncyclopediaB (GBE). He will also help you become a 
first-rate detective because, with the encyclopedia, you will 
uncover information just as real detectives do. 

FOR HELP If you need help while using the GBE program, see "Using 
the Help Menu" on page 38. 

If you can't find the answer you need in this book, call 
Jostens LearningB Product Support: a 

Product Support is available every weekday from 5:00 A.M. to 
4:00 P.M. Pacific standard time. 

ABOUT Since teachers can use the Golden Book Encyclopedia on 

WINDOWS AND both Macintosh" computers and computers running 

MACINTOSH Microsoft" Windows@, this guide contains procedures for 

PROCEDURES both types of workstations. The steps are basically the same 
for both types of workstations with only slight differences in 
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the screens; so some illustrations in this book may not match 
exactly what you see on your screen. 

However, the guide does not include basic information on 
using the Windows or Macintosh environments themselves. 
If you don't know how to do basic tasks, such as opening 
menus or closing windows, refer to the documentation 
provided by the computer manufacturer. Excellent reference 
materials are available for all types of computer hardware. 

WHAT IS THE The GBE program is an online, interactive encyclopedia. You 

CBE PROGRAM? can use the encyclopedia in the following ways: 

Listen to or read articles and parts of articles. 

Watch short movies. 
Listen to animal sounds and music selections. 

There are more than 1600 articles, 200 tables, 3400 pictures 
and maps, and 700 movies, animations, sounds, and speeches 
in the GBE program. You can choose to explore one of them 
or all of them. 

THE MAIN The Main menu contains the paths and tool icons you will 

MENU use as you work in the encyclopedia. 
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The Main menu is divided into four paths. Each path helps 
you explore the encyclopedia in a different way. 

Inspector Golden's World of Words path organizes titles 
of articles by topics. 

Inspector Golden's Seek and Find path gives you 
questions to answer while you are using the 
encyclopedia. 
Inspector Golden's Sights and Sounds path lets you look 
at or listen to different pictures, movies, maps, speeches, 
and sounds to find an article that interests you. 

Inspector Golden's ABCs path lists all the articles in the 
encyclopedia in alphabetical order. 

For detailed steps on using the paths, see "Getting to 
Articles" on page 7. 

TOOLS 

The six small pictures along the Main menu are tool icons. 
Each tool helps you use the encyclopedia. 

Click the Main menu icon to open the 
Main menu. 

Click the Path icon while an article is 
open to return to the path you used to 
get to that article. 

Click the Tracker icon to open a list of all 
the articles you have viewed in the 
current session. 

Click the Bookmark icon to mark an 
article you want to return to later. 
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Click the Notes icon to open the 
Notebook and enter notes that you can 
save and print. 

Click the Say It! icon to have portions of 
an article or an entire article read to you. 

For more information about each tool, see "Using the Tools" 
on page 27. 

In addition to the tools on the Main menu, there are three 
icons that appear on the screens in the GBE program. 

Click the Hear icon to listen to the 
instructions for a screen or window. 

Click the Go Back icon to return to the 
last screen you were working on. 

Click the arrows in the upper-right 
comer of an article to move through the 
articles alphabetically. Click the left 
arrow to go to the previous article. Click 
the right arrow to go to the next article. 

G ~ I N G  You can learn to use the GBE program in two ways. You can 

STARTED explore at your own pace, or you can follow the step-by-step 
instructions in "Getting to Articles" on page 7. To find out 
how to start the GBE program, see the First Connections: The 
Golden Book Encyclopedia Procedures Card. 

EXPLORING ON If you already know how to use computers, you may want to 

YOUR OWN explore the GBE program by yourself. If you need help, use 
one of the online help options described below. 
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USING ONLINE The online Help has these options: 

HELP Introduction 

Paths 

Tracker 

Bookmark 

Notes 

Say It! 

About GBE (Windows workstations only) 

To use the online Help, follow these steps. 

1. Open the online Help menu. 

On Windows workstations, click Help. 

On Macintosh workstations, click the Help icon - 
in the upper-right comer of the screen. 

2. From the Help menu, choose Introduction. 

filled with ~ n t e r e s t ~ n g  words, pictures, movies and 
sounds, Inspector Golden serves as your guide 
throughout the encyclopedia. 

Here are a few tips to help you use L;PE 

You can use the File menu to do two things: 

3. To read all the information in the Introduction, click 
the down arrow on the scroll bar. 

If you continue to click the down arrow, you can read 
all of the online Help, including help on paths, articles, 
tools, and menus. 

4. Click Close to close the Help window. 

Now explore the GBE program by yourself, or try the 
suggestions in "Getting to Articles" on page 7. 
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In this chapter Inspector Golden will show you, step by step, 
how to find articles in the GBE program. When you begin the 
program, you see the Main menu on the screen and hear: 

"Do you know how you want to use the encyclopedia? Click 
a pathway to find articles." (On Macintosh workstations this 
message is repeated; on Windows workstations you hear it 
only the first time in each session.) 

The pages that follow show you how to use each path on the 
Main menu. 
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page 

8 

1 1  

13 

19 

In order to ... 

explore groups of topics 

answer interesting questions 

look at pictures, movies, 
and maps, and listen to 
sounds and speeches 

look up an article 
alphabetically by title 

- 

Use this path 

World of Words 

Seek and Find 

Sights and Sounds 

ABCs 



INSPECTOR The World of Words path groups articles by subject. 

GOLDEN'S To open World of Words, complete the following steps. 
WORLD OF 
WORDS PATH 1.  On the Main menu, click World of Words. 

Click a part of  the picture lo see 
more. 

The first time you go to the World of Words path, you 
hear: "Help me explore the encyclopedia. You can use 
this picture to find articles. Click a part of the picture to 
see more." 

Nine topics appear on the screen: 

Arts Center 

City 

Farm 

History Center 

The Land 

Learning Center 

Playground 

Science Center 

zoo 
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2. Click the topic you want to explore. 

For this example, click Zoo. 

Seven zoo attractions appear: 

The Aquarium 

Birds 

Botanical Garden 

Information Hut 

Insects 

Mammals 

Reptiles 

3. Click the zoo attraction you want to learn more about 

For this example, click Mammals. 
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Nine types of mammals appear: 

Burrowing Mammals 

Cat Family 

Desert Mammals 

Dog Family 

Flying Mammals 

Forest Mammals 

Grassland Mammals 

Rodents 

Water Mammals 

4. Click the mammal you want to learn more about. 

For this example, click Water Mammals. 

A list of articles on water mammals appears. 

5 .  Select dolphins and porpoises and click Open. 

An article about dolphins and porpoises appears on the 
screen. 

For more information on using articles, see "Looking at 
Articles" on page 21. 

6. Read through the article. 

To have the directions on the screen read to you, click 
Hear. 
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7. When you have finished with the article, do one of the 
following: 

To return to the World of Words menu, click the 
World of Words icon on the tool bar. 

To exit World of Words, click the Main menu icon on 
the tool bar. 

INSPECTOR The Seek and Find path gives you topics and questions to 

GOLDEN'S SEEK choose from. After you ask a question, a list of articles 

AND FIND PATH appears. In these articles, you will find the answer to your 
question. 

1. On the Main menu, click Seek and Find. 

The first time you go to the Seek and Find path, you 
hear: "Click the door to begin." 

2. Click the Questions door. 

A bulletin board with topics on it appears. 
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3. Click a topic. 

For this example, click Weather. 

A list of questions appears. Each topic has three to six 
questions. 

4. Select a question and click OK. 

For this example, select How is a cloud formed? 

A list of articles that contain the answer to the question 
appears. Every question has two or more articles that 
will help you answer it. 
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5. Select the article you want to read and click Open. 

For this example, select rain. The article on rain 
appears. You can read it to find the answer to your 
question. 

For more information on using articles, see "Looking at 
Articles" on page 21. 

6. Do one of the following: 

To return to the Seekand Find window,click the 
Seek and Find icon. 

To return to the Main menu, click the Main menu 
icon. 

INSPECTOR In the Sights and Sounds path, you can discover new articles 

GOLDEN'S by looking at pictures, movies, and maps and listening to 

SIGHTS AND speeches and sounds. 

SOUNDS PATH 
1. On the Main menu, click Sights and Sounds. 

The first time you use the Sights and Sounds path, you 
hear: "This bookcase holds some of my favorite sights 
and sounds. Click a part of the bookcase to explore." 
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2. Click one of the sights or sounds in the bookcase: 

Pictures 

Speeches 

Movies 

Maps 

Sounds 

1. Click Pictures to look at pictures from articles in the 
encyclopedia. 

Pictures appear in random order. 

2. To browse through the pictures available in the 
encyclopedia, click the arrows under the picture. 

Use the arrows to choose pidures that alphabetically 
precede or follow the current picture. 

3. If you want to return to the Sights and Sounds 
window, click Close (Macintosh workstations) or Go 
Back (Windows workstations). 

4. To open the article that tells more about the picture's 
topic, click Open. 

For information on using articles, see "Looking at 
Articles" on page 21. 
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5. When you have finished with the article, do one of the 
following: 

8 To return to the Sights and Sounds window, click the 
Sights and Sounds icon. 

8 To return to the Main menu at any time, click the 
Main menu icon. 

You can listen to famous speeches and then open the article 
that discusses the speech and the speaker. 

1. In the Sights and Sounds window, click Speeches to 
find a speech you want to hear. 

John F. Kennedy's Inaugural Speech 

When John F. Kennedy became president. he II 
challenged the Amerlcan people to do something v e y  
important. Llsten to his words. 'Ask not what your 
county can do for you, asw what you can do for  your 
country.- 

John F. Kennedy's Inaugural Speech from the artlcle Kennedy, 
John F. 

Click an arrow lo hear another speech. 

Speeches appear in random order. 

2. To browse through the speeches available in the 
encyclopedia, click an arrow to move through the 
speeches alphabetically. 

3. To listen to the speech, click Hear in the speech 
window (in the upper part of the window). 

4. If you want to return to the Sights and Sounds 
window, click Close (Macintosh workstations) or Go 
Back (Windows workstations). 
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5. To go to the article that tells more about the speech's 
topic, click Open. 

For information on using articles, see "Lookmg at 
Articles" on page 21. 

6. When you have finished with the article, do one of the 
following: 

To return to the Sights and Sounds window, click the 
Sights and Sounds icon. 
To return to the Main menu at any time, click the 
Main menu icon. 

Movies are short animation sequences or video clips that 
illustrate the topics in the encyclopedia. 

1. In the Sights and Sounds window, click Movies to 
find a movie you want to watch. 

I I Scuba Diver from the ar t ic le  underwater sports I I 
6 Click an arrow to see another movie. 

Movies appear in random order. 

2. To watch the movie, click Start. 

3. To see other movies, click an arrow to move through 
the movies alphabetically. 
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4. If you want to return to the Sights and Sounds 
window, click Close (Macintosh workstations) or Go 
Back (Windows workstations). 

5. To open the article that tells more about the movie 
topic, click Open. 

For more information on using articles, see "Looking at 
Articles" on page 21. 

6. When you have finished with the article, do one of the 
following: 

To return to the Sights and Sounds window, click the 
Sights and Sounds icon. 

To return to the Main menu at any time, click. the 
Main menu icon. 

Using the Maps option in Sights and Sounds, you can learn 
about different parts of the world. 

1. In the Sights and Sounds window, click Maps to find a 
map you are interested in. 

; North Rmerlcen Contlnent from the artlcle North Rrnerlca 

j [tloLB) (Open) I T )  
, . , , . . . , , . . . . . . , . . . . . . . . . . , . . . . . , . . , . . . . , . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
/;kC;Z) Ciick an an0111 to see another map. 

Maps appear in random order. 

Some maps are bigger than the screen. Use the arrows 
in the scroll bars to look at the entire map. 
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2. To browse through the maps, click the right or left 
arrow to look at maps that alphabetically precede or 
follow the current map. 

3. If you want to return to the Sights and Sounds 
window, click Close (Macintosh workstations) or Go 
Back (Windows workstations). 

4. To go to the article that tells more about the map, click 
Open. 

For more information on using articles, see "Looking at 
Articles" on page 21. 

5. When you have finished with the article, do one of the 
following: 

To return to the Sights and Sounds window, click the 
Sights and Sounds icon. 

To return to the Main menu at any time, click the 
Main menu icon. 

To listen to the sounds that represent topics, use the Sounds 
option in the Sights and Sounds window. 

1. In the Sights and Sounds window, click Sounds to find 
a sound you want to hear. 

Some tigers llve in  the cold forests i n  Siberia. Others 
live In  troblcal forests. Once there were many tigers 
roamlng aslo from Turkey l o  Chjna, but now they a m  
an endangered spscies. Listen to the roar of a tiger. 

Tiger Roar from the ar i ic le tiger 

2. To listen to the sound, click Hear in the Sounds 
window. 

Getting to Articles 
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3. To listen to other sounds, click one of the arrows. 

Use the arrows to move through the sounds that 
alphabetically precede or follow the current sound. 

4. If you want to return to the Sights and Sounds 
window, click Close (Macintosh workstations) or Go 
Back (Windows workstations). 

5. To open the article that tells more about the sound, 
click Open. 

For information on using articles, see "Looking at 
Articles" on page 21. 

6. When you have finished with the article, do one of the 
following: 

To return to the Sights and Sounds window, click the 
Sights and Sounds icon. 
To return to the Main menu at any time, click the 
Main menu icon. 

INSPECTOR The ABCs path lists articles in alphabetical order. Use this 

GOLDEN'S ABCS option when you know the name of the topic you want to 

PATH look up. 

1. On the Main menu, click ABCs. 
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The first time you go to the ABCs path, you hear: 
"Every article begins with a letter of the alphabet. Click 
a letter to see article names. Click an arrow to see more 
letters." 

2. To move through the alphabet, click the arrows above 
and below the letters. 

3. To see a list of articles starting with a particular letter, 
click the letter. 

For example, to find an article on amphibians, click the 
letter A. 

4. Click the down arrow in the scroll bar until you see 
the article amphibian. 

5. Select amphibian and click Open. 

The article about amphibians appears on the screen. For 
more information on using articles, see "Looking at 
Articles" on page 21. 

6. Do one of the following: 

To return to the ABCs menu, click the ABCs icon. 

To return to the Main menu at any time, click the 
Main menu icon. 
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Articles contain facts about various topics. Pictures, maps, 
movies, speeches, and sounds are article features that help 
you learn more about the topics they accompany. 
Throughout the program there are instructions on how to use 
the GBE features. This section tells you about the GBE 
features you can use when you are working in articles. 

To learn what you can do within an article, use a path to find 
an article you are interested in and then open the article. 

For help on how to use the paths to open an article, see 
"Getting to Articles" on page 7. 

SCROLLING You can move through an article by clicking the up or down 

THROUGH arrow on the scroll bar. This is called scrolling. 

ARTICLES For example, in the article on dance, you can scroll down to 
see information about the Minuet. 

Minuet 
I B 

These are the opening notes of Ludwig van 
Beethoven's Minuet. 

R c p r o d u d  from 'Mastus of aassial Mlslc' by pmn kSi0n 
of D d b  Mlsic Inc 

It was a stately dance in which the man and woman touched 
hands and bowed to each other. 
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MOVING TO You can move through articles alphabetically by clicking the 

OTHER ARTICLES green arrows near the top of the screen. The right arrow takes 
you to the next article. The left arrow takes you to the 
previous article. 

USING THE Some articles contain "See" and "See also" references. These 

"SEE" references direct you to other articles that give you more 

REFERENCES information about the subject on the screen. 

For practice, open the article on DNA. 

1. From the Main menu, click ABCs. 

Golba's ABCo 

.............................................................................................................................. 

lif buflefly 

Cllck a letter to see article names. 

Hsr 
Cllck an arrow to sea more IeHen. 

2. From the letter bar, click the letter D. 

3. Scroll through the articles and select DNA. 

Use the scroll bars to scroll through the list until you 
find DNA. 

4. Click Open. 

5. Scroll to the end of the article until you find "See also 
cell; genetics; and heredity" printed in green. 
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6. Click one of the article titles (cell, genetics, or 
heredity). 

The article for the topic you clicked appears on the 
screen. 

7. When you have finished looking at the articles, do one 
of the following: 

To return to the ABCs screen, click the ABCs icon. 

To return to the Main menu, click the Main menu 
icon. 

WATCHING A In some articles, you can watch a short movie. For example, 

MOVIE WITHIN in the article on kangaroos, you can watch a kangaroo jump. 

AN ARTICLE 
1 .  From the Main menu, click ABCs. 

2. Use the arrows above and below the letters to locate 
the letter K. Click the letter K. 

3. Scroll through the list of articles and select Kangaroo. 

4. Click Open. 
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5. Scroll through the article until you find the movie of 
the Kangaroo. 

Jumping Kangaroo Ksngamos jump t o  g e t  from place t o  

Some kangaroos can be found in swampy areas, while 
thers l ~ v e  in deserts or dry grasslands. Kangaroos 

6. To watch the movie, click Start. 

7. When you have finished watching the movie, do one 
of the following: 

To return to the ABCs screen, click the ABCs icon. -- 

o To return to the Main menu, click the Main menu 
icon. 

LISTENING TO You can also listen to sounds in an article. For example, listen 

SOUNDS to the noisy frogs and toads in the article titled amphibian. 

WITHIN AN 
ARTICLE 1 .  From the Main menu, click ABCs. 

2. Click the letter A. 

3. From the list of articles, select amphibian and click 
Open. 
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4. Scroll through the article on amphibians until you 
find the magenta box labeled "Noisy Frogs and 
Toads" with the Hear icon. 

1 ;  con see thsm in zoos, pet storss, and 

- :  in  your own backyard1 These anlmsls areknown as 
I -  f nrnphiblans. 

' I Frogs, toads, salamanden, newts, and caecelians belong to1 
a gkup  of an~mals called amphibians. This name means 
"double life.'Plost amphibians spend the first part of thei 
lives in water. They spend some or all of the adult part of 
their lives on land. 

Amphibians are vertebrates. This means they have 
backbones, as do fish, reptiles, b~rds, and mammals. 
Sometimes people confuse amphibians and reptiles. An 
amphibian has soft, moist skin; a reptile has dry, scaly 

5. Click Hear to listen to the frogs and toads. 

6. Leave the article open. 

PRINTING You can easily print GBE articles. Print the article on 

ARTICLES amphibians. 
With the article you want to print open, choose Print 
from the File menu. 

To learn how to print Notes, see "Printing Your Notes" on 
page 33. 

Q U I ~ I N G  AN After you are finished with an article, you can look for 

ARTICLE another one, go to another path, or close GBE. 

To go back to the path you used to find 
the article, click the Path icon. 

To go back to the Main menu, click the 
Main menu icon. 
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To close GBE, do one of the following: 

On Macintosh workstations, choose Quit from the 
File menu. 

On Windows workstations, choose Exit from the 
File menu. 
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USING THE TOOLS 

This section shows you how to use the tools in the GBE 
program. The tool icons appear on the left side of the screen. 

USING THE Use the Main menu tool to return to the GBE 
MAIN MENU Main menu. From the Main menu you can 
TOOL choose different paths. 

USING THE The Path tool tells you which path you used 

PATH TOOL to get to the article you are viewing. When 
you open an article, the Path icon becomes a 
picture that shows you which path you used. 
The picture is different for each path. 

USING THE The Tracker tool lists the articles you went to 

TRACKER TOOL and the paths you used during the current 
session. Articles are listed in the order you 
opened them. If you have opened at least one 
article in this session, you can easily return to 
any article using the Tracker tool. 

1 .  Click the Tracker icon. 

A list of the articles you opened in this session appears. 

children's books 
westward mowment 
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2. To see a list of the articles you opened in a particular 
path, click the appropriate path icon on the right. 

For example, to see a list of all the articles you read 
while working in the World of Words path, click the 
World of Words icon. 

3. To return to any of the articles on your list, select its 
title and click Open. 

The Tracker window closes and the article appears. 

USING THE Use the Bookmark tool when you want to 

BOOKMARK mark an article so you can return to it later. 

TOOL 

ADDING A BOOKMARK 

To place a bookmark in an article, you must be in the article. 

1. Click the Bookmarks icon. 

If this is your first bookmark, you see the dialog box in 
step 2. After you add your first bookmark, the 
Bookmarks dialog box shown below appears. 

Bookmarks 

:..; away 

1 6 Click your choice. (XZi-] 1 
2. Click add. 

Add a Bookmark I 
Click OK to  add a bookmark to the article called 
"amphibian " 
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3. To add a bookmark, click OK. 

After you click OK, the Bookmarks dialog box closes 
and you see the article again. 

To go to an article marked with a bookmark, complete the 
following steps. 

1 .  Click the Bookmark icon. 

The Bookmarks dialog box appears. 

Bookmarks 

pqqqp-q 
m 4 ) Click your choice. (r) 

2. Click go to. 

A list of the bookmarks you have set appears. 

3. Select the article title you want to go to and click 
Open. 

The article appears. 
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When you do not want to keep a bookmark you have set, you 
can throw it away. 

1. Click the Bookmark icon to open the Bookmarks 
dialog box. 

Bookmarks 

@ Click your choice. [r] 

2. Click throw away. 

A list of your bookmarks appears. 

3. Click the article title of the bookmark you want to 
throw away and click OK. 

USING THE The Say It! tool reads sentences and entire 

SAY IT! TOOL articles for you. L€ the Say It! icon is not 
dimmed, you can use it. 

1. If you want a sentence read to you, highlight the 
sentence you want to hear. 

To highlight words, put the cursor to the left of the first 
word you want to highlight. Click and hold down the 
mouse button, drag the pointer to the last word you 
want to highlight, and release the mouse button. 
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